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Sound Byte is a computerized cart machine program. It is very similar to 
the so-called cart machines used at radio stations in the past. Each clip 
(recording) - a jingle, advertisement, etc, was on a cartidge, which could be 
quickly selected and played. Following this introduction are chapters that 
explain how to use and register (pay for) your copy of Sound Byte.

Sound Byte brings the cart machine to the computer age. You can assign 
select up to 75 recordings to a rack, and assign each to a button. Clicking on 
a button plays that recording. Multiple recordings can be played at the same 
time. 

Sound Byte comes in three versions:

Sound Byte Lite handles up to a single rack of carts, or 75 clips. The 
registration fee is only $39.

Sound Byte handles up to 5 racks of carts, or 375 clips.  The registration 
fee is only $79.

Sound Byte Pro a try, which supports up to 50 racks, or 3750 clips.  The 
registration fee is only $149.

Until you buy your copy, it will operate like the Lite version. In addition, the 
program will occasionally display reminder messages.

Sound Byte handles all of the audio formats supported by QuickTime, 
including:
AIFF
WAV
AU
MP3
AAC/m4a



If you'd like to create your own recordings, please give our program 
Audiocorder a try. It may be downloaded from the following URL:
http://www.blackcatsystems.com/software/audiocorder.html

Note that Audiocorder is only available for the Macintosh.

If you were using version 2.x of Sound Byte, you can use the Import Rack 
option under the File menu to import the carts from the previous version of 
Sound Byte. To import an older rack, perform the following steps:

1. Run the new version of Sound Byte.
2. Open up a blank Rack by selecting it from the Racks menu (if the rack has 
entries in it, it will be overwritten). 
3. Select Import Rack... from the File menu.
4. In the open dialog window, navigate to the old rack file you wish to import.
5. Open it. Nothing will appear to happen, that is normal
6. Close the rack window.
7. Re-open the rack window

Sound Byte is the perfect application to use whenever you need to quickly 
and easily play a variety of recorded sounds.

Possible Uses:
Radio Stations - jingles, advertisements, PSAs, songs, announcements, and 
more.

Plays and radio/TV productions - perfect for playing sound effects.

DJs - set up your play-list for the evening.

Sporting events - play sound effects when the home team scores, etc.



Requi rements:

Macintosh:  Mac OS X 10.2 or later, Mac OS 9 also supported. QuickTime is 
required, it is usually installed by default on Macintosh systems.

Windows: Windows 2000 or XP. QuickTime must be installed. It can be 
downloaded for free from this URL: 
http://www.apple.com/quicktime/download/win.html

Insta l lat ion:

After decompressing the download archive, you’ll have a folder containing 
the Sound Byte program, this documentation that you’re reading now,  an 
order form, as well as a folder called Racks. All of the racks that Sound Byte 
makes are stored in this folder, and it is very important that you keep it in 
the same location relative to Sound Byte. That is, if you move SoundByte, 
you need to move the Racks folder as well, so that it is in the same folder 
that the Sound Byte program is. You can always make an alias or shortcut to 
the program, and put that on your desktop, or wherever you wish.  You need 
to keep the Playlists folder with the Sound Byte application, as well.

If you’re running under Mac OS X and have installed a disk image file 
containing Sound Byte, please be sure to move the Sound Byte folder to your 
hard drive before trying to run it. That is, don’t try to run it off a mounted 
disk image.

If you want to put Sound Byte into the Mac OS X Dock, make an alias of the 
program icon, and put the alias into the Dock. 



Rack Window:

When you start the program, you'll see a window with 75 buttons, arranged in 
a 5 by 15 array. 

Each button represents one sound file (clip) that may be played.  This window 
is also called a “rack” - a term from back in older days of radio when 
recordings (songs, stations jingles, advertisements, etc) were all stored on 
cartridges, or carts for short. The carts were all kept on a rack. To play a 
song or ad, the DJ would grab the cart, plug it in, and play it. Many consoles 
allowed several carts to be queued up ahead of time, so the next one would 
always be ready to play. 

The top line of each button shows the title of the recording. By default it is 
the name of the file, but you can change it. Below this the length of the 
recording is shown, in Hours:Minutes:Seconds. At the bottom of the button is 



a volume control, so you can set the playback level for that particular 
recording. In the upper right corner of the button is an indicator that is 
normally black, and turns green when the recording is playing. Inside this, the 
hotkey character for the recording is shown. Each button can be assigned a 
hotkey, typing this key starts (or stops) the recording. You can also start a 
recording by clicking on the button. Click on the indicator, or the upper part 
of the button. Don’t click on the volume slider area. You can stop playback by 
clicking on the green indicator, or typing the hotkey again.

You can also navigate the carts by using the arrow keys. The up, down, left, 
and right keys will advance from the currently playing cart to the adjacent 
cart, and start it playing. You can also use the space bar to play the next (to 
the right) cart. This is handy if you need to play a sequence of carts in a row 
in order. Just set the up in the rack in the correct order, and hit the 
spacebar to start the next one. If you’re already in the right most column, 
hitting the space bar again will jump to the cart in the left most column of 
the next row.

If the buttons are too small, you can use the Change Cart Size item in the 
Action menu to display larger sized carts. 

Here’s what a button looks like when the recording is playing:

The second line now shows the elapsed playback time as well.

Clicking on the Mute button (or selecting Mute from the Edit menu, cmd-T) 
will mute any currently playing carts, which is handy during a voice-over, etc.

Also be sure to check the section on Preferences, which can set some useful 
features of Sound Byte.

There are two ways to assign a clip to a button. The first, and easiest way is 
to just drag the sound file into the button.  

Holding down the shift key when you drop the file will change the file that is 
played, but keep the button color, text, hotkey, etc all the same. 



To change the details of a cart button, right click on it, or, you can click on 
the button while holding down the command key (the alt key under Windows). 
This will bring up the a window called "Cart Options", shown below:

Clicking on the "Select Sound File..." button allows you to select the clip to 
associate with this button. If the file is grayed out in the open file dialog list, 
chances are the filetype is not set to one of those recognized by Sound Byte 
as a valid file.  Filetypes recognized are: 

'AIFF'
'MooV'
‘Mp3 '
'MPEG'
'MPG3'
'sfil'
'Sd2f'



'ULAW'
'WAVE'
'????'

It’s always possible that the filetype of the recording file is not recognized 
by Sound Byte. You can try dragging the file onto an empty cart, and see if it 
is recognized.

The name of the file is automatically used as the button title. If you'd like to 
change the title, type the name you'd like to assign to this sound clip in the 
field called Title. You'll want do do this after you select the sound file, or the 
name you've typed in will get replaced by the name of the sound file, and 
you'll have to enter it in again.

If you select the Abort other sounds playing option, then whenever you 
play this sound, any other sounds that are currently playing will automatically 
be stopped. This can be much more convenient than having to manually stop 
the other sounds that may be playing.

When Click restarts playback is checked, a cart will restart playback 
from the beginning when clicked, rather than stop playback.

If you select the Loop option, then when the sound is done playing, it will 
automatically be re-played.

If you select the Disable After Playing option, then when the sound is 
done playing, the cart will automatically be disabled. It will appear faded in the 
Rack, and you won’t be able to play it again until you’ve selected the Reset 
Disabled Carts option in the Edit menu. This is useful when you only want to 
play a sound once, and don’t want to accidently play it again, and want to 
make it so that unplayed sounds are more obvious in the Rack window.

The Play Backwards option will cause playback to start at the end of the 
recording, and it will be played backwards. Note that there may be some 
clicking or other distortions to the sound when this option is used, nothing 
can be done about that. Please be sure to fully test this option before using 
it in a production setting, if it is important to you. 

The Click Start Aborts Others option, when enabled, will stop playback of 
any other carts which are playing, when this cart is clicked to start playback. 



This works the same as the option in the Sound Byte preferences, but allows 
a cart-by-cart control of this feature.

The Click Pauses Playback option, when enabled, will pause playback of 
this cart when the cart button is clicked, rather than stopping playback 
which is the default operation. This works the same as the option in the 
Sound Byte preferences, but allows a cart-by-cart control of this feature.

If you select the Lock Volume option, then the volume slider can’t be 
adjusted. This is to prevent accidently changing the volumne setting when 
you click on a cart to play it.

You can also assign a hot key to this sound. This allows you to play the clip 
by just typing that key, without using the mouse. Hot key's may include the 
shift key, that is, you can use both upper and lower case letters.  If you’d 
like to use one of the function keys (F1, F2, etc) type in the function key 
name (which must be in upper case). Note that some function keys have 
special uses with various operating systems, and may not be used. 

Clicking on the "Set Button Color..." button lets you change the color of the 
button. This can be very handy if you want to color code buttons to make 
them easier to find. You'll get a color picker window, with lots of options, 
depending on which operating system you're running. Select the color, then 
click on OK.

If you want to change several carts to the same color, the easiest way is to 
change one of them, then select Copy Cart Color under the Maintenance 
menu. An open hand cursor will appear. Click on the cart with the color you 
wish to apply to other carts. The cursor will change to a closed hand. Then 
click on the other carts you wish to change to that color. When you’re done, 
hit the ESC key, and the cursor will change back to the normal pointer.

The Fade Rate field specifies how quickly the sound fades to silence when you 
select the Fade Current Cart item from the Edit menu. Larger numbers 
cause faster fades, and the fading rate is linear. A value of 1, for example, 
fades from maximum volume to complete silence in about 32 seconds. A 
value of 8 does the same fade in about 4 seconds. 

In and Out set the starting and ending (referenced from the end of the 
track) time to be played. For example, an In time of 4 means that playback 



will start 4 seconds into the track. An Out time of 7 means that playback will 
be stopped 7 seconds before the end of the track. This can be used to 
eliminate silence, or parts of the track that you don’t want to play.

Fadeout specifies when (referenced from the end of the track), the cart 
should automatically start to fade out. For example, 5 means that 5 seconds 
before the end of the track, it will begin to fade (at the specified Fade Rate). 

Clicking on the Details button will bring up a window that shows the location 
of the sound file.

You can use the Rate value to change the playback speed. A value of 1 will 
play back at the normal speed. A value of 1.1 would be 10% faster than 
normal, 2 would be double speed, etc. Negative values can be used for 
reverse playback, although the sound may be distorted.

The Pitch value, as expected, controls the pitch of the audio. Here, zero is 
normal pitch, a value of 1.0 would be an increase of one cent, 100.0 is one 
semi-tone up, and 1200.0 would be one octave higher. Negative values can be 
used to lower the pitch.

The Repeat value allows a cart to be automatically replayed. Enter in a time 
(in HH:MM:SS) as the repetition period. When you click on the cart, it will play 
normally. Then, after the repetition period, it will be played again, and so on. 
This can be used to play periodic announcement messages, etc. When this is 
active, the indicator box in the upper right corner will be blue, rather than 
the suual black. To stop the periodic playback, click on the cart again, and 
the indicator will turn back to black from blue.

The MIDI value allows you to specify which note on a connected MIDI keyboard 
will cause the sound file to play (it works just like a hotkey). You need to have 



MIDI enabled in the Sound Byte Preferences for this to work. Just hit the 
note on the keyboard and the value will appear in the entry box, or type in 
the note value.

Using the popup menu at the bottom of the window, you can select the sound 
output device to use, if you want the sound to play on a device other than 
the default. You can also specify the channel numbers to use (if your device 
has more than two output channels) for the left and right outputs. These 
settings will override any in the overall Sound Byte preferences.

When you're done, click on the OK button.  Clicking on the Clear button will 
erase the button name and file association, essentially erasing the button 
entry.



Drag and Drop

If you want to move buttons around (within the same rack), you can just drag 
one button on top of the other. They will automatically trade places. If you 
want to replicate a button, hold down the shift key as you drag it to a blank 
cart, and you will get a copy. If the destination cart is not blank, it will be 
overwritten. You need to grab the lower right corner of the cart to be able to 
drag it.

Playing a Sound

To play a clip, just click on the button, or type the hot key. The indicator in 
the upper right of the button will turn green, to show that the clip is playing. 

The volume slider can be used to adjust the playback volume of the cart. You 
can also position the mouse cursor over the cart, and use the scroll wheel.

Clicking on the indicator while the clip is still playing will stop playback. You 
can have more than one clip play at the same time.

You can stop all currently playing clips by pressing the ESC (escape) key.

Holding down the control key while clicking on a button will bring up a window 
that will let you specify the starting point in the recording to begin playback. 
This is useful if you do not want to start playback at the beginning. After 
entering in the start time and clicking OK, the cart will be paused. Select 
Pause Playing Carts from the Edit menu (control or command U as the 
shortcut) to begin playback.

More About Racks

Under the Rack menu is a list of the racks available. To chose a new rack, 
just select it from the menu. The name of the rack can be changed by 
selecting “Rename...” from the Rack menu while that rack is the currently 
active window.

Your rack is automatically saved when you quit the program, or close it.

If instead of the volume slider, you’d rather see a progress bar showing the 



amount of the cart that has played so far, select Show Play Progress from 
the Edit menu. Each cart will now look like the following:

With this view enabled, you can click on the progress bar to set the playback 
position of the cart. You do this while it is playing, or before it plays, to cue 
the position, then click on the cart to start playback.

Clicking on the cart while holding down the shift and control keys will bring up 
a window to allow you to precisely cue the playback start time, down to the 
second.

You can select Show Volume Sliders to get the sliders back, or select Show 
Nothing if you’d rather see neither.

Selecting Max All Volumes from the Edit menu will set all volume sliders to 
the maximum volume.

Selecting Fade Current Cart from the Edit menu will fade the volume of the 
currently playing cart over a few seconds. This operation of this function is 
undefined if you have more than one cart playing. You can select the fade 
rate for each cart by cmd-clicking on the cart to bring up the editing window 
for that cart.

Selecting Pause Playing Carts from the Edit menu will paue the playback of all 
active carts. Selecting it again will start them playing from were they left 
off.

If you want to add several files to a rack at once, select all them, and drop 
them onto the small area labled “Drop Files Here”. Each file will be assigned 
to an empty cart button.  You can always re-arrange the order of the carts 
by dragging them around, if they don’t land in the order you wish.

Clicking the MUTE button will mute playback of carts. Clicking with TALK 
button will change the volume to a lower setting, you can adjust this setting 
while TALK is pressed, and it will be saved for the next time you press TALK. 
This can be useful when doing voice-overs.





Queuing Carts

You can queue carts on a rack, so that as soon as one cart is done playing, 
the next queued cart will play. This lets you quickly and easily specify a 
sequence of carts to play, without having to manually start each cart at 
exactly when the previous cart ends.

To do this, you must enabled queuing in the Sound Byte preferences if you 
would like to be able to queue all carts, or you must enable it on a cart by 
cart basis. When a cart (or all carts) are enabled for queuing, you lose the 
ability to play two or more of those carts at the same time.

When a cart is playing, if you click on another cart (or type the hotkey for 
it), that second cart will not start playing immediately, but will instead be 
queued. When the first cart is done playing, it will then start playback.

Carts that are queued will have a number displayed on the cart, in a large 
blue font, indicating the position in the queue. Number 1 means that cart will 
start playing immediately after the currently playing cart stops, queued cart 
2 will play next, and so on. As the carts move up in the queue, the displayed 
numbers will update.

If you have two or more carts with the same hotkey, and type the hotkey to 
queue them, both will be queued, but they will not play at the same time. The 
first cart (as defined by highest row and leftmost column) will play first, 
then the next cart.



Archiving Racks

You can archive the contents of a rack (along with the referenced sound 
files). This archive can be used as a backup, or as a way to move an entire 
rack to another computer. Note that this feature is only available with the 
Regular and Pro versions of Sound Byte, not the Lite version.

To archive a rack, open and select that rack window, then choose Archive 
from the Management menu. You will be asked to specify the name of archive 
file to be created. The archiving process can take some time, depending on 
the size of the various sound files. A progress bar will update during the 
archiving process.

To unarchive, you need to open and select the rack window that you wish the 
archive file contents to be restored to. Note that all of the existing carts on 
that window will be erased (the referenced sound files themselves will not be 
affected). Select Unarchive from the Management menu. You will be asked to 
specify the name of archive file, and the destination folder, where the sound 
files will be stored.

By default, all of the sound files will have a four digit number prepended to 
their name. This is to handle the situation where the rack has carts that 
reference two or more sound files of the same name (but originally stored in 
different directories), so that the unarchived files do not overwrite each 
other. During the unarchiving process, you will alerted to this renaming, and 
given the option to not perform it, if you wish, at your risk.

If you wish to move the rack to another computer, you need to copy the 
archive file to the second machine, which must have a licensed copy of Sound 
Byte installed. Then run Sound Byte, unarchiving the file as described above. 
Both copies of Sound Byte must be the same version number, and the same 
platform (you cannot transfer between Mac and Windows, and on the Mac you 
cannot transfer between PPC and Intel systems).



Play List

The Play List allows you to select cuts to play ahead of time, organize them 
in a list, and control their playback.

For each recording in the playlist, the title (name of recording file), length in 
Hours : Minutes : Seconds is shown, as well as how much time into the 
playback session that recording will start. A small black dot appears to the 
right of the title of the active (currently playing or next to play) recording.

To create a play list, select New PlayList... from the File menu. You’ll be 
asked to name the play list when you close the window, so it can be saved. If 
you save your playlists in a folder called Playlists, you can bring up a list of 
all of the playlists in that folder by selected Show Play Lists Window from 
the File menu. Just double click on a playlist in that window to open it.

You can drag a cart over to the play list window from a button on the main 
window, or you can drag a sound file over directly from Finder.  Drop it onto 
the “Drag Files Here” box to have them appended onto the end of the play 
list, or drag them into the position where you want them. You can always 



change the order of items in the play list up or down, by dragging the entries 
around.

You can then drag additional cuts over. Dragging them after cuts already in 
the play list schedules them later. Dragging them onto an existing scheduled 
cut schedules them before that cut.

You can delete a scheduled cut by selecting it, and selecting Clear from the 
Edit menu. You can can also re-arrange the order by dragging entries 
around.

You can open an existing play list by selecting Open Play List from the File 
menu, and then selecting the play list file. 

The play list has seven buttons. Let’s go through them in order from left to 
right:

 Play - Clicking this button starts playback of the selected recordings, in 
order. A small dot is displayed next to the active (playing) cut.

 Stop - Clicking this button stops playback. Clicking Play again will start 
the active recording, at the beginning.

 Pause - Clicking this button pauses playback. Clicking Play will start it 
again, right where it left off, not at the beginning of the recording.

 Skip - Clicking this button will stop playback of the currently playing 
recording, and start playback of the next. Think of it as a way to abort a 
cut, and jump right to the next one.

 Rewind - Stops playback, and selects the first recording as the active 



recording. When play is clicked, the first recording will start playback.

 Loop - When depressed, the loop button will cause the playlist to start 
over again, after the last cut is finished.

 Play One Cut - Click once to select, again to de-select. When selected, 
only one recording will be played when Play is clicked. Pressing Play again will 
play the next recording. Useful to queue up several recordings in a row, and 
play them one by one, under your control as to when they start.  For 
example, sound effects for a play or other production, etc.

Hitting either the spacebar or return/enter key when a playlist window is 
active will begin playback of the currently selected track.

The up and down arrow  keys can be used to navigate up and down through 
the list of tracks.

The left arrow key will restart (or start) playback of a track.

The right arrow key will stop playback of the current track and start 
playback of the next track.

Add Pause - Clicking this button adds an entry called PAUSE PLAYBACK. You 
can drag this entry to position it wherever you wish, and you have have 
several of these in a playlist. When playback reaches this entry, it will stop. 
You can then click the play button to start playback again with the next 
entry. This allows you to create a playlist for an extended time period, where 
you will only want to play a few tracks in a row, wuch as a series of 
commercials or other announcements, songs, etc. 

Add Delay - Clicking this button adds an entry called DELAY PLAYBACK. You 
can drag this entry to position it wherever you wish, and you have have 
several of these in a playlist. When playback reaches this entry, it will stop, 
then resume after a specified time period. This period defaults to 10 
seconds, and may be changed by double clicking the DELAY PLAYBACK entry.

The Cross Fade entry can be used to specify a time period, in seconds, over 



which the currently playing track will be faded out, while the next track will 
be faded in.

Each  track also has a Cut In and Cut Out time, in seconds, that you can 
specify. The track will start playing at the Cut In time, and the end of the 
track will be ofset by the Cut Out time (for example, if a track is 3 minutes, 
20 seconds long, and the Cut Out time is 5 seconds, then it will stop playing 
at 3 minutes, 15 seconds).

To change the Cut In or Cut Out times, or to delete a track, double click on it 
to bring up an editing window.

There is a volume control for each playlist, which controls the playback 
volume of tracks on that list.

Your play list is automatically saved when you quit the program, or close it.

You can open a window with a list of all of the playlists that are in your 
Playlists folder by selecting Show Play Lists Window from the File menu. 
Double clicking on an entry will automatically open that playlist. Note that you 
need to save your playlists in the Playlists folder for them to appear in the 
listing.

You can drag and drop a playlist file onto a cart button in a rack. When you 
do this, the name of the playlist will appear as the cart’s title. If you click on 
the cart, the playlist will open, and the first track in the playlist will play. 
Each subsequent click on the cart will play the next track of the play list.

A playlist can be made to open and play when a cart button is pressed. Drag 
and drop the file for the playlist (from the Finder or Windows Explorer, not 
the list of playlists within Sound Byte itself) to a cart. The name of the cart 
will become the name of the playlist. 

When this cart is run, the playlist will automatically open, and playback will 
begin. If the playlist is set to only play one track at a time, then only the 
first track will play, each subsequent click of the cart (or press of the 
hotkey) will play the next track.

The popup menu can be used to specify the sound output device, and the left 
and right channels can also be specified (or leave them black to use the 



defaults).



Timed Play List

The Timed Play List allows you to create a set of sound files, each one will 
play at a user defined time of the day. This can be a handy way to have lead 
in or out jingles play at certain times, without manual intervention. Very 
useful for a live show, for example. You could have a certain clip 
automatically start to play at certain times, to remind you that it’s time to 
go into a break.

Create a new timed play list window, and then drag sound files (or carts) into 
it.  The start time for each recording will default to 00:00:00 which is 
midnight. Go to this value, and click it twice to allow you to edit it. You can 
then change it to whatever time of the day you wish. Use 24 hour time, that 
is, 2 PM would be 14:00:00.  When you close the window for the first time, or 
if you have made changes to it, you’ll be asked to give it a name so it can be 
saved. 

When the specified time of any recording in an opened timed play list window 
is reached, that recording will start to play. You can have multiple recordings 



play at the same time, if you wish.

You can open a window with a list of all of the timed playlists that are in your 
Playlists folder by selecting Show Timed Play Lists Window from the File 
menu. Double clicking on an entry will automatically open that playlist. Note 
that you need to save your timed playlists in the Playlists folder for them to 
appear in the listing.

By selecting Reset Start Times from the Management window, the start 
times for each track in a timed playlist window can be changed. You will be 
presented with a small window, where you specify the start time for the 
first track (it will default to the current time). Each subsequent track’s 
start time will also be changed, keeping the same relative spacing between 
start times as previously existed.



P re fe rences

The following preferences can be set:

Space skips to next cart
Hitting the spacebar will cause the next cart (to the right) to start playing.

Space aborts playback
Pressing the spacebar will stop playback, handy if hitting the small ESC key is 
too difficult. 

Arrow Keys Don’t Start Cart Playback
Using the arrow keys (or remote) to move the selector to chose the next 
cart to play won’t actually start playback, you need to press enter to do 
that.

Check for IR Remote
Will check for the presence of an Apple IR Remote (only works on Mac OS X). 
If found, you can use the up/down/left/right buttons to select the cart to 
play next, and the play button to play it. 

Cart start aborts other carts playing
Starting a cart will stop any other playing cart(s)



Play Carts Continuously
After one cart ends, the next cart (to the right) will play. When the end of a 
row is reached, the first cart in the next row wil play. 

Click on playing cart pauses playback instead of stopping it
Instead of stopping, a currently playing cart will pause when the cart button 
is clicked. Playback will resume when it is clicked again.

Fadeout cart rather than stopping it
Instead of abruptly stopping, a currently playing cart will fade out when 
another cart is started.

Turn entire cart green when playing
Checking this will turn the entire cart green, rather than just the small 
activity box, making it easier to see which cart is playing.

Flash cart red when nearing end
Checking this will cause the cart to flash red when it is nearing the end of 
playback.  Enter the number of seconds before the end of playback in the 
box next to the option.

Time Offset
This allows you to take into account time delays.  Enter a value here in 
seconds. The clock on the rack window will run ahead by this amount. Any 
timed play lists will then start ahead of time by this amount as well.

Check For Updates
When checked, Sound Byte will check each time you start the program to see 
if there is a newer version available. No information is sent other than your 
current OS, version and registration information, so that the server can see 
if there is a new version available for you. You can disable this feature by 
unchecking the box.  

Click restarts playback
When checked, a cart will restart playback from the beginning when clicked, 
rather than stop playback.

Log Files Played



When checked, Sound Byte will update a text file with a line each time a cart  
is played. This is useful for tracking what files are played, for royalty and 
other purposes. Click on the File button to specify the name of the log file.
Each entry contains the date, time, cart name, and file name, all comma 
delimited.

Load Sound Files To RAM
When checked, Sound Byte will load each sound file in a rack to the 
computer’s memory. This can reduce the delay before playback, at the 
expense of taking longer to load a rack, and potentially using a lot of 
memory.

Randomly Play Hotkey Carts
Normally, if more than one cart has the same hotkey, typing that hotkey will 
result in all those carts being played. When this option is checked, only one of 
the carts, randomly selected, will play.

Serial Port
If a serial port is selected in the popup menu, Sound Byte will assert the RTS 
and DTR lines when a sound file is being played. This can be used to control 
external hardware, such as a transmitter.

MIDI
When enabled, Sound Byte will allow notes from a MIDI keyboard to initiate 
sound file playback. If no MIDI input device can be found, an error message 
will be displayed when Sound Byte starts. You can also specify a MIDI note 
value that will abort sound playback, much like the ESC key. Just hit the note 
on the keyboard and the value will appear in the entry box, or type in the 
note value.

Be sure to plug in your MIDI device before running Sound Byte.

Sound Output Device
you can select the sound output device to use, if you want the sound to play 
on a device other than the default. You can also specify the channel numbers 
to use (if your device has more than two output channels) for the left and 
right outputs.



Locking Sound Byte Against Unauthorized Changes

It may be desirable to prevent users from making accidental changes to cart 
settings and rack layouts. This can be done by selecting Lock Settings from 
the Edit menu, and checking the checkbox. 

When checked, users will not be able to edit cart options, drag carts, or add 
new carts to racks.

To re-allow changes to be made, uncheck this checkbox.



Computer User Account Issues

Under some computer operating systems, there can be issues where Sound 
Byte is run under more than one user account, since the location of the file 
where some settings are stored varies for each user account. There is now 
an option to have this file stored in the same directory (folder) as the Sound 
Byte application itself. If you wish to do this, run Sound Byte once under a 
user account. Find the file SoundBytePrefs (use your computer’s search 
feature to locate it, as each operating system puts it in a different location) 
and move it (or make a copy) to the same folder that contains the Sound 
Byte application itself.  From now on, when Sound Byte is run, it will use this 
file to store the settings.



Buying Sound Byte

Sound Byte is distributed as shareware, if you continue to use it, you're 
required to register your copy. Until you register, the program will 
occasionally display reminder messages, and you'll be limited to ten minutes 
of use at a time.

By purchasing your copy of Sound Byte, you'll help support the program, and 
encourage the development of future releases. 

After buying, you'll be entitled to one year's worth of updates and new 
program versions.

The registration fees for each version are as follows:

Sound Byte Lite $39

Sound Byte $79

Sound Byte Pro $149

When you buy Sound Byte you'll receive a registration code, by email, usually 
within a few minutes. If you don't get your registration code within a day or 
two, please send an email to: info@blackcatsystems.com.

If you want to use Sound Byte on multiple computers, you'll need to register 
a copy for each computer. If you'll be using Sound Byte on many computers, 
you may want to take a look at our site licensing options, which can save you 
a great deal of money.

Thanks again for giving Sound Byte a try.  

Black Cat Systems
4708 Trail Court
Westminster, MD 21158
USA

email:    info@blackcatsystems.com
Web:      http://www.blackcatsystems.com/software/soundbyte.html



Ordering by Check or Money Order

To order by check, please print, fill out and mail the following form, along with your payment. 
You can pay with a wide variety of cash from different countries but at present if you pay via 
check, it must be a check drawn in US Dollars. While there is the risk of loss in the mail, 
currency is also OK, including foreign currency.

Please make sure you include your email address with your payment. That way we can send the 
registration code to you, so you must include your email address. If you do not send us a valid 
email address, we have no way to send you the code. Please write clearly.

I would like to buy ____ copies of Sound Byte Lite, at $39 US per copy.

I would like to buy ____ copies of Sound Byte, at $79 US per copy.

I would like to buy ____ copies of Sound Byte Pro, at $149 US per copy.     

__ I would also like a CDROM with a copy of all of Black Cat Systems software, including Sound 
Byte, for $10 including shipping.

Email Address: ______________________________________________

Name: ___________________________________________________

Address: __________________________________________________

City: _______________________   State/Province:_________________

ZIP/Postal Code: __________________  Country: ___________________

Computer Model: _______________________         OS Version: _________

Enclosed, please find my check / money order / cash in the amount of $_______
Maryland Residents please add 6% sales tax.

All payments must be in either checks/money orders in US dollars drawn on a US Bank, or an 
International Money Order. If this is inconvenient, or you would like to order with a credit card, 
please order online at http://www.blackcatsystems.com/register/soundbyte.html

Mail this form, along with payment, to:

Black Cat Systems
4708 Trail Court
Westminster, MD 21158
USA



Ordering Online By Credit Card

To order online with a credit card, go to the following URL:
http://www.blackcatsystems.com/register/soundbyte.html

Please make sure you include your email address when you orer online. That 
way we can send the registration code to you, so you must include your 
email address. If you do not send us a valid email address, we have no way to 
send you the code.



Entering Your Registration Code

When you register Sound Byte, you'll receive an email containing your 
registration code. Select Register... from the File menu, and enter the 
code into the window that appears, along with your Name and Email address 
(optional):

 
Please be sure to enter your name and registration code exactly as shown 
in the registration email you received. Your code is locked to your name.



Sound Byte Version History

4.1.2- October 2, 2011
Several bug fixes.

4.1.0 - July 22, 2010
Added rack archiving
Several additions for future versions of the iPhone/iPad remote control apps 

4.0.3 - June 11, 2010
Fixed a bug that would sometimes cause a rack window to not be correctly positioned when 
opened.

4.0.2 - May 28, 2010
Bug fixes related to the iPhone and iPad remote control apps.

4.0.1 - March 18, 2010
Bug fix - The sound devices menu was blank in a newly created Playlist window.

4.0.0 - February 18, 2010
Added the option to play a radomly selected cart when a group of carts are all assigned the same 
hotkey.

3.9.7 - November 19, 2009
Fixed a bug with playlists - dragging an entry past the bottom of the list could cause a crash, or 
duplication of another entry.

3.9.6 - November 6, 2009
Added the TALK button to change the volume of playing carts.
Can double click on a playlist entry to edit/delete it.
Added queuing option for carts.
Added ability to fade in playback of a cart by holding down shift and option/alt while clicking on 
the cart button.
Bug fix - Alphabetizing carts did not update rack window
Bug fix - Clearing rack did not clear cart names in spreadsheet window.
Bug fix - Indicator on cart not always turned off when a playlist is stopped.
Bug fix - Queuing and playing playlists assigned to cart buttons.
Bug fix - Properly resetting the cart volume after a fadeout.

3.9.5 - August 17, 2009
Bug fix - clicking on the progress indicator of an unused cart could cause a crash.

3.9.4 - August 13, 2009
Fixed a problem with the displayed cart title not changing after being edited.

3.9.3 - August 3, 2009
Fixed a problem with the cart title not appearing after a new file was dragged into a cart.

3.9.1 - July 22, 2009



No longer attempts to mount an unmounted volume on startup.
Reduced the delay in resetting the volume of a cart after a fade.
Fixed a protential crashing problem under Windows, when scrolling a rack window.

3.9.0 - May 12, 2009
Fixed a bug with default sound output channels.
Corrected a registration code issue.
Playlist windows can now specify the output device and channels to use.
Add... button added to the playlist window to directly select a sound file without dragging and 
dropping it.
Can delete playlist entries.
Fixed a bug that could cause a crash when a playlist window is closed.
Added a delay option to playlists.
Added control of which channels to use on sound output devices.
Remembers the size and position of the cart window.

3.8.0 - February 26, 2009
Added MIDI input.
Added support for using Function Keys as hotkeys

3.7.0 - October 30, 2008
Added an option to automatically display playlist windows that are assigned to carts.
Added an option to lock settings against unauthorized changes.
Added repeat option to carts.
When the cart size is made larger, the entire rack is now displayed.
Added the Click Pauses Playback option to the card options.
Added the Click Start Aborts Others option to the card options.
Fixed a bug that could cause a crash when pauses are used in a playlist.
Control-arrow keys can be used to adjust the volume of the selected cart while it is playing.
Can paste the registration code email into the registration code window.
Playing carts now show elapsed and remaining time.

3.6.0 - September 11, 2008
Added option to load sound files to memory.
Added options to set the playback pitch and rate of carts.
Added remote control option.
Added an option to toggle a serial port line when a track is playing.
Fixed a bug with the playback progress indicator
Fixed a bug that could cause a crash with the logging feature.

3.5.2 - May 29, 2008
Cart buttons that represent a PlayList now show the title of the next track
Bug fix: The first track in a Playlist would not always play.

3.5.1 - May 29, 2008
Bug fix: Pauses in play lists did not work.
Bug fix: Sdding a pause to a play list could cause a crash/
Bug fix: Clicking on a progress bar on a cart linked to a play list could cause a crash.
Bug fix: bringing up the QuickTime details for an empty cart could cause a crash.



3.5.0 - April 24, 2008
The lock volume sliders menu option now also locks the progress indicator as well.
Added an option for a local preferences file in the application’s folder.
Added a better explanation of an expired registration code.
Added option to drag a playlist into a cart button.
Added the ability to vertically alphabetize carts in a rack.
Copy and Paste can be used in a Timed Playlist to duplicate entries.
Added an option to reset all Timed Playlist start times based off of the current or a specified 
time.

3.4.6 - February 21, 2008
Added an option to allow carts to be played backwards.
Click restarts playback now works with hotkey presses as well.
Fixed Apple IR Remote support for Leopard.
Bug fix - Some times the wrong cart would fade out.
Bug fix - play one track option in the playlist would not always work.
Bug fix - one second delay added before restoring the cart volume after a fade.

3.4.5 - November 29, 2007
Bug fix - couldn’t drag carts.

3.4.4 - November 29, 2007
Added icons for play list files.
Playlist windows retain their last position and size.
Click Restarts Playback now available on a per cart basis.
Bug fix - missing file would cause a timed play list to crash.
Bug fix - Mute did not completely mute looping sound effects.
Bug fix - playlists wouldn’t work correctly if the crossover time was left blank.

3.4.3 - October 4, 2007
Mouse scroller can be used to change the cart volume.
Added a menu item to close the frontmost window.
Added ability to pre-set playback starting position by clicking in the progress bar.
Added a window display a list of all timed playlists.
Checks to see if it is in a directory without write privileges, and quits if so.

3.4.1 - August 7, 2007
Added a volume control to playlists.
Bug fix - playlists didn’t use the selected sound output device.

3.4.0 - June 7, 2007
Added log file.
Added display of loop symbol for carts that will loop.

3.4.0 - June 7, 2007
Fixed a bug that could cause a crash if an invalid timed playlist file was opened.



3.4.0b2 - May 4, 2007
Added preferences option: clicking on a playing cart restarts it from the beginning.
Fixed a bug in the Cart Options window that made the Lock Volume checkbox disappear.

3.4.0b1 - April 24, 2007
Playing carts can’t be edited
Renamed Cart Editing to Cart Options, changed OK button to save
Made a confirm window for clear cart
Made a confirm window for alphabetize carts
Added a way to copy cart colors between carts
Cut in time for carts is now in tenths of a second
Added cut in and out times for playlists
Added fade time for playlists
If a cart is paused, clicking on it will unpause
Location of the Cart Options window is preserved.

3.3.1 - April 20, 2007
Bug fix - clicking on the Details button for an empty cart would cause a crash.

3.3.0 - March 29, 2007
Added ability to select sound output device.
Added support for Apple IR Remote.
Can right click to open cart editing window.
Added menu item to lock/unlock all volume sliders in a rack.
Added continuous option to play carts one after the other in order.
Added option to allow the spacebar to abort playback like the ESC key.
Can set In and Out times for a cart.
Can set fadeout time for a cart.
Added option to copy a cart.

3.2.1 - February 22, 2007
Fixed a bug that could cause a crash by clicking in an empty playlist.

3.2.0 - February 22, 2007
Release

3.2.0b3 - February 13, 2007
Added Timed Play List.
Added clock on the rack window.
Added a time offset option to handle time delays.

3.2.0b2 - December 18, 2006
Added option to turn entire cart green when playing.
Added option to flash cart red when playback is almost over.

3.2.0b1 - December 14, 2006
First release with Universal Binary support.

3.1.6 - October 4, 2006



Improvements to reduce CPU utilization.

3.1.5 - October 4, 2006
Fixed a bug that could prevent a playlist from being saved.

3.1.4 - September 15, 2006
Sped up the opening of a rack window.

3.1.3 - September 11, 2006
Fixed a bug that could cause a crash when closing a rack or playlist window.

3.1.0 - September 6, 2006
Added option to import older rack files.
Added resize and scrolling of racks window.
Control-clicking a cart lets you start it at at an arbitrary point in the track.
Added window for quick access to all playlists.
Added indicator bar to playlist windows showing elapsed time.
Added option to add a pause playback marker to playlists.
Spacebar and return now start playback in a playlist window.
Arrow keys can be used to navigate a playlist window.
Left arrow will re-start a track in the playlist.
Right arrow will skip to the next track in the playlist.
Only need to click on an entry in the playlist to select it, not double click.
Fixed a bug that could cause playlist sound output to glitch.
Fixed a bug that could cause scroll bars to not be shown when they should.
Fixed a bug that could cause a crash when Sound Byte is launched.
Fixed a bug that could cause a crash if a rack was closed while a cart was playing.

3.0.0 - July 27, 2006
Improvements to sound playing under heavy computer load conditions.
Final Release.

3.0.0b4 - July 11, 2006
Added Clear Rack function.
Added function to alphabetize the carts in a rack.
Fixed a bug that could cause the regular version of Sound Byte to not allow all five racks to be 
used.

3.0.0b3 - June 11, 2006
Fixed a bug that could cause a crash if you tried to edit an empty cart.
Fixed a bug that caused some registration codes to not be accepted.

3.0.0b2 - May 6, 2006
Corrected some bugs with fading

3.0.0b1 - April 24, 2006
First beta release of Version 3

2.7.1 - March 26, 2006



Fixed a bug that could cause a crash when opening a Rack.

2.7.0 - January 8, 2006
Mute feature, kill sound output for voice-overs, etc.
Added preferences option for spacebar to play the next cart
Added preferences option to abort other playing carts when playing a new one
Added preferences option to pause playback of carts
Added preferences option to fade carts out 
Fixed a bug that could cause a crash if the Playlist window is used without a Rack window being 
open.

2.6.3 - October 7, 2005
Fixed a bug that could cause Sound Byte to crash when started up, if no Rack 
files exist. 

2.6.2 - October 7, 2005
Fixed a bug on systems with multiple volumes, where Sound Byte could lose track of sound files 
stored on volumes other than the startup volume. 

2.6.1 - September 27, 2005
Fixed a bug that could cause long waits when adding sounds.

2.6.0 - August 29, 2005
Added large display of details on the currently playing cart.
Enlarged the size of the displayed hotkey for better visibility.
Added feature to change volume numbers for all recording files in a rack.
Added a hot spot in the PlayList window in which to drop recordings.
Fixed a bug with fading - if a cart finished playing wile fading, the next cart played would start 
fading.
Some Tiger Mac OS X 10.4 related bug fixes.

2.5.0 - February 14, 2005
Auto-set cart size when a rack is opened.
Can now use space bar and arrow keys to navigate carts.

2.4.0 - February 14, 2005
Added the ability to display fewer but larger carts, for increased visibility.
Fade times can now be programmed individually for each cart.
Carts can be set to be disabled after being played, to make it easier to identify carts that have not 
been played yet.
Removed being able to click anywhere on cart to stop playback as it caused the sound to stop 
playing if you adjusted the volume. Now you need to click in the upper part of the cart button, 
where the title and playing time are located.



2.3.0 - November 4, 2004
Can now click anywhere on cart to stop playback.
Can now clear entries in Playlist window.

2.2.0 - May 12, 2004
Can pause the playback of currently playing carts.
Can start a cart at a particular time into the recording.
Can now drop multiple files into a rack at the same time.
Can clear all entries in a rack.
Volume indicators and progress displays for unused carts not shown.
After a fade, cart volume is now returned to previous setting.
Added checking for latest version and visiting website to About menu.
When a cart is dragged, the color now correctly updates immediately.

2.1.0 - March 4, 2004
Added the ability to fade the currently playing track.
Added display showing the elapsed time of currently playing tracks.
Added the ability to change the volume ID for cart recording files.

2.0.2 - February 6, 2003
Added ‘Sd2f’ and ‘MPG3’ filetypes to those recognized as valid sound files.

2.0.1 - January 12, 2003
Bug fix - couldn’t click on carts.

2.0.0 - January 11, 2003
Bug fix - couldn’t access sliders on bottom row of rack
Preferences menu item disabled (there are no preferences)

2.0.0b2 - November 30, 2002
Fixed bugs with saving play lists
Fixed bugs that could cause a crash when closing a rack
Fixed bugs with play list buttons
Fixed bugs with dragging clips

2.0.0b1 - First release of Mac OS X test version



Sound Byte Version History

Software License Agreement
This is a legal agreement between you and Black Cat Systems. covering your use of Sound Byte 
(the "Software"). Be sure to read the following agreement before using the Software. BY USING 
THE SOFTWARE (REGARDLESS IF YOU HAVE REGISTERED THE SOFTWARE OR 
NOT), YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THE 
SOFTWARE AND DESTROY ALL COPIES IN YOUR POSSESSION.

The Software is owned by Black Cat Systems and is protected by United States copyright laws and 
international treaty provisions. Therefore, you must treat the Software like any other copyrighted 
material (e.g., a book or musical recording). Paying the license fee allows you the right to use one 
copy of the Software on a single computer. You may not network the Software or otherwise use it 
or make it available for use on more than one computer at the same time. You may not rent or lease 
the Software, nor may you modify, adapt, translate, reverse engineer, decompile, or disassemble the 
Software. If you violate any part of this agreement, your right to use this Software terminates 
automatically and you must then destroy all copies of the Software in your possession.

The Software and its related documentation are provided "AS IS" and without warranty of any kind 
and Black Cat Systems expressly disclaims all other warranties, expressed or implied, including, but 
not limited to, the implied warranties of merchantability and fitness for a particular purpose. Under 
no circumstances shall Black Cat Systems be liable for any incidental, special, or consequential 
damages that result from the use or inablility to use the Software or related documentation, even if 
Black Cat Systems has been advised of the possibility of such damages. In no event shall Black Cat 
Systems's liability exceed the license fee paid, if any.

This Agreement shall be governed by the laws of the State of Maryland. If for any reason a court of 
competent jurisdiction finds any provision of the Agreement, or portion thereof, to be 
unenforceable, that provision of the Agreement shall be enforced to the maximum extent 
permissible so as to effect the intent of the parties, and the remainder of this Agreement shall 
continue in full force and effect.

The Software and documentation is provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the 
Rights in Technical Data and Computer Software clause as 252.227-7013.  Manufacturer is Black 
Cat Systems., 4708 Trail Court, Westminster, MD 21158, United States of America. 

The name "Black Cat Systems", and  "Sound Byte" are trademarks of Black Cat Systems.

Sound Byte is ©1997-2011 by Black Cat Systems. All rights reserved worldwide.


